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1 What's New

New features in ODBC Driver for Salesforce Marketing
Cloud 1.12

Fixed connection timeout setting before opening connection

Now secrets and passwords are stored in an encrypted form in the DSN record

Added metadata cache

New features in ODBC Driver for Salesforce Marketing
Cloud 1.11

Added "Server to Server" authentication mode

New features in ODBC Driver for Salesforce Marketing
Cloud 1.10

Added the Support Extension Objects connection option

Added support for SQL_ATTR_MAX_ROWS attribute

Improved compatibility with Visual Basic in Visual Studio

Improved compatibility with Linked Server in SQL Server

Improved compatibility with Alteryx

New features in ODBC Driver for Salesforce Marketing
Cloud 1.9

Improved compatibility with Linked Server in SQL Server 2019

Improved compatibility with Tableau Prep Builder

Improved compatibility with Crystal Reports

New features in ODBC Driver for Salesforce Marketing
Cloud 1.8

Added support for Windows 11

Improved compatibility with FICO Mosel
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Improved compatibility with FileMaker

Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for Salesforce Marketing
Cloud 1.7

MSI installer for deploying through GPO is added

New features in ODBC Driver for Salesforce Marketing
Cloud 1.6

The ReturnForeignKeys connection option to significantly improve performance is added

Compatibility with Visual Studio is improved

SQLProcedures now returns an empty recordset instead of an error

SQLProcedureColumns now returns an empty recordset instead of an error

New features in ODBC Driver for Salesforce Marketing
Cloud 1.5

Performance of obtaining metadata is improved

Support for connection pooling is improved

Now ODBC driver activation does not require administrator privileges

New features in ODBC Driver for Salesforce Marketing
Cloud 1.5

Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for Salesforce Marketing
Cloud 1.4

Possibility to return String Types as Ansi or Unicode is added

Compatibility with MS Access is improved

Compatibility with Tableau is improved

Compatibility with Omnis Studio is improved
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Compatibility with Power Pivot is improved

Compatibility with DBeaver is improved

New features in ODBC Driver for Salesforce Marketing
Cloud 1.3

App center client authentication is supported

Connection Timeout option is added

Query Timeout option is added

New features in ODBC Driver for Salesforce Marketing
Cloud 1.2

Compatibility with SAS JMP is improved

Compatibility with MS Power Query is improved

OUTER JOIN macros in SQL queries are supported

DateTime macros in SQL queries are supported

Scalar function macros in SQL queries are supported

New features in ODBC Driver for Salesforce Marketing
Cloud 1.1

Compatibility with MS Visual Studio

Compatibility with MS FoxPro is improved

Compatibility with MapInfo is improved

Compatibility with Libre Office is improved

Compatibility with Qlik is improved

Compatibility with Delphi & C++Builder is improved

MS Access linked tables support is improved

New features in ODBC Driver for Salesforce Marketing
Cloud 1.0

First release of ODBC Driver for Salesforce Marketing Cloud
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Windows 32-bit is supported

Windows 64-bit is supported

© 2015-2024
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2 General Information

1. Overview

2. Features

3. Compatibility

4. Requirements

5. Licensing

6. Getting Support

© 2015-2024
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Reserved.
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2.1 Overview

Overview
Devart ODBC Driver for Salesforce Marketing Cloud is a high-performance connectivity

solution with enterprise-level features for accessing Salesforce MC from ODBC-compliant

reporting, analytics, BI, and ETL tools on both 32-bit and 64-bit Windows. Our ODBC driver

fully supports standard ODBC API functions and data types and enables easy and secure

access to live Salesforce MC data from anywhere.

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
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Connection to Salesforce MC

Our data connector enables various ODBC-aware applications to connect to Salesforce MC

directly via HTTPS. If you have no direct access to Salesforce MC via HTTPS, you have the

option of establishing a connection through a proxy server.

© 2015-2024
Devart. All Rights
Reserved.

Request Support ODBC Forum Provide Feedback

2.2 Features

Connection to Salesforce

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
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MC

Our connectivity solution enables various

ODBC-aware applications to connect to

Salesforce MC directly via HTTPS. If you

have no direct access to Salesforce MC,

you have the option of establishing a

connection through a proxy server.

Extended SQL Syntax

Our ODBC driver provides an unrivalled

opportunity to work with Salesforce MC

objects just as with SQL tables. The

extended SQL syntax allows you to use all

the SQL benefits in SQL-92 compatible

SELECT statements:

Complex JOINs

WHERE conditions

Subqueries

GROUP statements

Aggregation functions

ORDER statements

and more.

https://www.devart.com/odbc/exacttarget/
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DML Operations

Devart ODBC Driver for Salesforce MC

provides support for DML (INSERT,

UPDATE, DELETE) operations, which

allows you to modify data in Salesforce MC

in the same way as in SQL databases.

Bulk Updates

Moreover, with our driver you can perform

bulk updates to Salesforce MC by

combining SQL statements into batches,

thus simplifying and speeding up large data

modification with Salesforce MC.

ODBC Conformance

The driver provides full support for common

ODBC interface:

ODBC API Functions support

ODBC Data Types support

In addition, we provide support for

Advanced Connection String parameters.

Thus allowing any desktop and web

applications to connect to Salesforce MC

from various environments and platforms,

that support ODBC.
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Salesforce MC

Compatibility

Our ODBC driver fully supports all data

types defined in the Salesforce MC API.

Moreover, the driver is compatible with the

Salesforce MC API itself.

Advanced Data Conversion

We have implemented advanced Data

Conversion mechanisms that provide bi-

directional mapping between any

Salesforce MC and ODBC data types.

Integration

The driver is compatible with 3rd-party data

analysis tools, such as Microsoft Excel, and

integrates with various IDEs and systems

like Visual Studio, etc.

For a complete list of compatible tools and

platforms, see Compatibility.

Platforms Variety

Devart ODBC Driver for Salesforce MC

can be used with 32-bit and 64-bit

applications on both x32 and x64 platforms,

so there is no need to additionally configure

the driver, applications or environment.

Fully Unicode Driver

With our fully Unicode driver, you can

retrieve and work with any data from multi-

lingual Salesforce MC databases correctly,

not depending on whether its charset is

Latin, Cyrillic, Hebrew, Chinese, etc., in any

environment localization.
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High Performance

Every operation with Salesforce MC

becomes significantly faster using such

capabilities of our driver as Local data

caching, connection pooling, query

optimization and much more.

Support

Visit our Support page to get instant help

from knowledgeable and experienced

professionals, a quick resolution of your

problems, and nightly builds with hotfixes.

© 2015-2024
Devart. All Rights
Reserved.

Request Support ODBC Forum Provide Feedback

2.3 Compatibility

Salesforce MC Compatibility

Salesforce MC API

Salesforce MC Data Types

Supported Platforms
Windows 32-bit and 64-bit (including Windows Terminal Server)

Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

  Application Development Tools

Adobe ColdFusion

Embarcadero Delphi & C++Builder
  UniDAC, FireDAC, dbGo (ADO), BDE and dbExpress

https://www.devart.com/odbc/exacttarget/support.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/odbc/exacttarget/


ODBC Driver for SalesforceMC10

© 2024 Enter your company name

FileMaker

Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio
  Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

Python

  Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

SQL Server Reporting Services

  BI & Analytics Software

Alteryx
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DBxtra

Dundas BI

FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle BI

Power BI

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

TIBCO Spotfire

  Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

StarOffice

© 2015-2024
Devart. All Rights

Request Support ODBC Forum Provide Feedback

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
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Reserved.

2.4 Requirements

The following requirements must be met for ODBC Driver for Salesforce Marketing Cloud:

Only one version of ODBC Driver for Salesforce Marketing Cloud is installed on your

system.

.NET Framework 4.5 or later is installed on your system.

© 2015-2024
Devart. All Rights
Reserved.

Request Support ODBC Forum Provide Feedback

2.5 Licensing

ODBC Driver License Agreement

--------------------------------------------------

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING

THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND

BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE

TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND

PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you

(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver

software application, demos, intermediate files, printed materials, and online or electronic

documentation contained in this installation file. For the purpose of this Agreement, the

software program(s) and supporting documentation will be referred to as the "Software".

LICENSE

1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,

subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/odbc/
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registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop

computer, provided it is accessed by no more than one person at a time, either directly or

remotely, for sole purposes only in accordance with this Agreement. If more than one person

can simultaneously use the computer where you plan to install the product, you must

purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it

is accessed by more than one person at a time, either directly or remotely. This definition

includes, but is not limited to, Web servers, application servers, batch servers, and desktop

workstations, where more than one concurrent users can access the Software. A Server

License is valid for one single server installation, provided it is used by 1 (one) legal entity in

accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the

registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single

computer only during the subscription term specified at purchase. An Internet connection is

required to activate the license and check the license status when the Software is used.

Once the subscription term is over, you will be able to either stop using the Software or renew

the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version

on a single computer without an active subscription. A subscription provides access to new

product releases, regular upgrades, and support for new server versions provided during the

subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a

single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in

a single company as well as deploy the Software as part of a licensee's application to web

servers, application servers, batch servers, desktops, and other end-user devices. This

definition includes the ability to install and use the application containing the Software without

any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:
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- make one copy of the Software for archival purposes only, or copy the Software onto the

hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.

1.4. If you have the "OEM License", you are also entitled to:

- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into

your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation

section.

No other rights or privileges are granted in this Agreement.

2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions

of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written

permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your

Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the

Software license is non-transferable, and you may not transfer the Software installation

package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights

notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs

(Applications) created using the Software. You cannot distribute the Software integrated into

your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's

exclusive property.
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4. TRANSFER

You may not transfer the Software to any individual or entity without express written

permission from Devart. In particular, you may not share copies of the Software under

"Desktop License"  with other co-developers without obtaining proper license of these copies

for each individual; you may not install the Software under "Server License" on more than 1

(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the

event of any failure to comply with any provision of this Agreement. Upon such termination

you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or

distribute Trial versions of the Software as an original installation package only. If the Software

you have obtained is marked as a "Trial" version, you may install and use the Software for a

period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the

additional restriction that it is used solely for evaluation of the Software and not in conjunction

with the development or deployment of any application in production. You may not use

Applications developed using Trial versions of the Software for any commercial purposes.

Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all

accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart

makes no warranties, expressed or implied, including, but not limited to, the implied

warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to

download improvements and enhancement from Devart's web site as they become available,

during the active subscription period. The initial subscription period is one year from the date

of purchase of the license. The subscription is automatically activated upon purchase, and

may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users

of the Software with an active subscription may request technical assistance with using the
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Software over email from the Software development. Devart shall use its reasonable

endeavors to answer queries raised, but does not guarantee that your queries or problems

will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database

versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by

international copyright laws and treaty provisions. You may not remove the copyright notice

from any copy of the Software or any copy of the written materials, accompanying the

Software.

This Agreement contains the total agreement between the two parties and supersedes any

other agreements, written, oral, expressed, or implied.

© 2015-2024
Devart. All Rights
Reserved.
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2.6 Getting Support

This document lists several ways you can find help with using ODBC Driver for Salesforce

Marketing Cloud describes the Priority Support program.

Support Options
There are a number of resources for finding help on installing and using ODBC Driver for

Salesforce Marketing Cloud:

You can find out more about ODBC Driver for Salesforce Marketing Cloud installation or

licensing by consulting Installation and License articles of this manual respectively.

You can get community assistance and technical support on the Community Forum.

You can get advanced technical assistance by ODBC Driver for Salesforce Marketing

Cloud developers through the ODBC Driver for Salesforce Marketing Cloud Priority Support

program.

Subscriptions

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://support.devart.com/portal/en/community/odbc-drivers
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The ODBC Driver for Salesforce Marketing Cloud Subscription program is an annual

maintenance and support service for ODBC Driver for Salesforce Marketing Cloud users.

Users with a valid ODBC Driver for Salesforce Marketing Cloud Subscription get the following

benefits:

Product support through the ODBC Driver for Salesforce Marketing Cloud Priority Support

program

Access to new versions of ODBC Driver for Salesforce Marketing Cloud when they are

released

Access to all ODBC Driver for Salesforce Marketing Cloud updates and bug fixes

Notifications about new product versions

Priority Support
ODBC Driver for Salesforce Marketing Cloud Priority Support is an advanced product support

service for getting expedited individual assistance with ODBC Driver for Salesforce Marketing

Cloud-related questions from the ODBC Driver for Salesforce Marketing Cloud developers

themselves. Priority Support is carried out over email and has a two business day response

policy. Priority Support is available for users with an active ODBC Driver for Salesforce

Marketing Cloud Subscription.

To get help through the ODBC Driver for Salesforce Marketing Cloud Priority Support

program, please send an email to odbc@devart.com describing the problem you are having.

Make sure to include the following information in your message:

Your ODBC Driver for Salesforce Marketing Cloud Registration number.

Full ODBC Driver for Salesforce Marketing Cloud edition name and version number. You

can find the version number in DLL version information.

Versions of the Salesforce MC server and client you are using.

A detailed problem description.

If possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Salesforce Marketing Cloud.

If you have any questions regarding licensing or subscriptions, please see the FAQ or

https://www.devart.com/odbc/exacttarget/
mailto:odbc@devart.com
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contact sales@devart.com

© 2015-2024
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3 Using ODBC Driver

1. Installation

2. Product Activation

3. Connecting to Salesforce MC

4. Connection String Parameters

5. Enabling ODBC Tracing

6. Supported Data Types

7. Supported ODBC API Functions

© 2015-2024
Devart. All Rights
Reserved.
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3.1 Installation

ODBC Driver for Salesforce Marketing Cloud currently supports Windows 32-bit and 64-bit.

Regular Installation

Silent Installation

© 2015-2024
Devart. All Rights
Reserved.
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3.1.1 Windows

Installation on Windows
1. Download and run installer executive file.

2. Follow the instructions in the wizard.

mailto:sales@devart.com
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/odbc/exacttarget/download.html
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3. In case you already have the specified installation folder on the PC or another Driver

version is installed, you will get a warning. Click Yes to overwrite the old files with the

current installation, but it is recommended to completely uninstall the previous driver

version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the

driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.
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5. In the License Information dialog box, you should select the license type and activate the

product. If you have no activation key, you can select Trial and use the driver for evaluation

purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from

the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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7. If you have the activation key file, click the Load Activation Key button and browse to it.

8. Click Next.

9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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3.1.2 Silent

Silent Installation with OEM license on Windows
1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCExactTarget.exe /SILENT /ActivationKey=y1c7nmgdu234laszxcvONGurjfhxm90LHuyhhsae

DevartODBCExactTarget.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtrilwq98nbvl4RTukfgre

Note: The installation is performed by entering a license key.

DevartODBCExactTarget.exe /SILENT /ActivationFile=d:\lic.key

DevartODBCExactTarget.exe /VERYSILENT /ActivationFile=d:\lic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is

required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation

process is performed without user interference.

© 2015-2024
Devart. All Rights
Reserved.
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3.2 Product Activation

Obtaining Activation Key

Activation on Windows

Where to see the license information

© 2015-2024
Devart. All Rights
Reserved.
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https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
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3.2.1 Obtaining Activation Key

To obtain a product activation key, follow these instructions:

1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal

account.

4. To login to the Customer Portal, use your Username and Password from the registration

email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:

6. Copy the Activation Key with the Copy to Clipboard button.

See also:
Activation on Windows

© 2015-2024
Devart. All Rights
Reserved.
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3.2.2 Activation on Windows

Driver Activation After Installation

https://secure.devart.com
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html
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To activate your installed driver using ODBC Administrator, perform the following steps:

1. Run ODBC Administrator.

2. In the System DSN tab click the Add button.

3. In the appeared dialog box, select the installed driver, click Finish.
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4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.
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3.2.3 Where to See the License Information?

To see the license information of your installed driver, do the following:

1. In the Control Panel run ODBC Administrator

2. Open the System DSN tab and click the Add button

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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3. Select the driver and click Finish
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4. In the appeared dialogue, select the License tab
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See also
Product Activation
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3.3 Connecting to Salesforce Marketing Cloud via ODBC Driver

3.3.1 User/Password Authentication

Windows DSN Configuration
After installing the driver, create a DSN for Salesforce MC in the ODBC Data Source

Administrator.

1. Open the ODBC Data Source Administrator.

Type ODBC Data Sources in the Windows 10 search box and choose the ODBC Data

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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Sources application that matches the bitness of your application (32-bit or 64-bit). You

can also open ODBC Data Sources from Control Panel > Administrative Tools. Note

that before Windows 8, the icon was named Data Sources (ODBC).

Alternatively, you can run C:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or C:

\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN. Most applications work with any of them, yet some

applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog appears.

4. Select Devart ODBC Driver for Salesforce Marketing Cloud and click Finish. The driver

setup dialog opens.

5. Enter the connection information in the appropriate fields.

6. To test the connectivity, click Test Connection.

7. Click OK to save the DSN.
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See Also

Connection Options
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3.3.2 App Center Client Authentication

Windows DSN Configuration
After installing the driver, create a DSN for Salesforce MC in the ODBC Data Source

Administrator.

1. Open the ODBC Data Source Administrator.

Type ODBC Data Sources in the Windows 10 search box and choose the ODBC Data

Sources application that matches the bitness of your application (32-bit or 64-bit). You

can also open ODBC Data Sources from Control Panel > Administrative Tools. Note

that before Windows 8, the icon was named Data Sources (ODBC).

Alternatively, you can run C:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or C:

\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN. Most applications work with any of them, yet some

applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog appears.

4. Select Devart ODBC Driver for Salesforce Marketing Cloud and click Finish. The driver

setup dialog opens.

5. Enter the connection information in the appropriate fields.

6. To test the connectivity, click Test Connection.

7. Click OK to save the DSN.

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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Connection Options
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3.3.3 Server to Server Authentication

Windows DSN Configuration
After installing the driver, create a DSN for Salesforce MC in the ODBC Data Source

Administrator.

1. Open the ODBC Data Source Administrator.

Type ODBC Data Sources in the Windows 10 search box and choose the ODBC Data

Sources application that matches the bitness of your application (32-bit or 64-bit). You

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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can also open ODBC Data Sources from Control Panel > Administrative Tools. Note

that before Windows 8, the icon was named Data Sources (ODBC).

Alternatively, you can run C:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or C:

\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN. Most applications work with any of them, yet some

applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog appears.

4. Select Devart ODBC Driver for Salesforce Marketing Cloud and click Finish. The driver

setup dialog opens.

5. Enter the connection information in the appropriate fields.

6. To test the connectivity, click Test Connection.

7. Click OK to save the DSN.

See Also
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3.4 Connection String Parameters

Salesforce MC ODBC Connection String Parameters
The following table lists the connection string parameters for Salesforce Marketing Cloud.

Server to Server Authentication

Option Description

Subdomain
Used to provide subdomain, which is a 28-character string starting with

the letters “mc”,

App Client

Id

Used to supply application center client ID for server-to-server

authentication.

App Client

Secret

Used to supply application center client secret for server-to-server

authentication.

Paramet
er

Description

Authenticati

on

Used to specify the authentication type when connecting to Salesforce

Marketing Cloud. The available values are:

UserandPassword

AppClientCenter

ServerToServer

The default value - UserandPassword.

Partner IDs The list of specific partner accounts or business units for retrieve requests.

User and Password Authentication

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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Server

The server address to connect to. Devart ODBC Driver for Salesforce

Marketing Cloud can connect to Salesforce Marketing Cloud (formerly

known as ExactTarget) CRM servers. The default value is https://

webservice.s7.exacttarget.com/Service.asmx.

User ID
Used to supply a unique User ID to connect to a Salesforce Marketing

Cloud account.

Password Used to supply a password to login to Salesforce Marketing Cloud.

App Center Client Authentication

Client ID Used to supply Application Client ID for App Center Client authentication.

Client

Secret

Used to supply Application center client secret for App Center Client

authentication.

Sandbox
Allows using a production or sandbox account for App Center Client

authentication.

Proxy Settings

Proxy

Server
The proxy hostname or IP address.

Proxy Port The proxy port.

Proxy User The proxy username.

Proxy

Password
The proxy password.

Advanced Settings

Allow NULL

strings

To retrieve metadata, not all parameters according to MSDN can accept a

null value. If NULL, the driver should return an error. But some 3rd-party

tools pass NULL to the parameters. These options should be enabled for
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compatibility with such tools.

Empty

strings as

NULL

Connection

Timeout

The time (in seconds) to wait for a connection to open before terminating

an attempt. The default value is 60.

Extension

Objects

ODBC Driver for Salesforce Marketing Cloud allows creating custom

objects called Data Extensions. If the parameter is set to true, the data

extension information will be read and processed in the same way as the

predefined Salesforce Marketing Cloud objects are. Please note that

reading data extension information might take additional time.

ODBC

Behavior

Used to set the behavior corresponding to the ODBC specification

version that a third-party tool expects. The behavior of ODBC driver can

be changed by setting a value for the SQL_ATTR_ODBC_VERSION

attribute by calling the SQLSetEnvAttr function. But some third-party tools

expect the driver to exhibit ODBC 2.x behavior, but forget to call

SQLSetEnvAttr with the specified version or pass an incorrect value there.

In this case, the required behavior can be explicitly specified in the

Connection String by setting the ODBC Behavior parameter. The possible

values are:

Default - default ODBC behavior determined by a third-party tool.

Ver 2.x - ODBC 2.x behavior is explicitly set.

Ver 3.x - ODBC 3.x behavior is explicitly set.

RegionalNu

mberSetting

s

Enables the use of local regional settings when converting numbers to

strings.

RegionalDat

eTimeSettin

gs

Enables the use of local regional settings when converting dates and

times to strings.
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ReturnForei

gnKeys

Use the parameter to specify whether the driver must return foreign keys.

Retrieving metadata about foreign key constraints is a time-consuming

operation; many third-party tools request foreign key metadata even whey

they do not actually need this information. Note that enabling the option

may degrade performance of data access operations. The default value is

False.

String Types

Sets the string value types returned by the driver as Default, Ansi or

Unicode.

Default - the driver defines the string types.

Ansi - all string types will be returned as SQL_CHAR, SQL_VARCHAR

and SQL_LONGVARCHAR.

Unicode - all string types will be returned as SQL_WCHAR,

SQL_WVARCHAR and SQL_WLONGVARCHAR.

The parameter value should be changed if any third-party tool supports

only Ansi string types or Unicode ones.

QueryTimeo

ut

The time to wait for a query execution result before terminating and

generating an error.

UTC Dates

Specifies whether all the datetime values retrieved from the data source

are returned as UTC values or converted to local time and whether the

date values specified on the application side (e.g., in SQL statements) are

considered UTC or local. The default value is false.

SalesforceMC ODBC Connection String sample

DRIVER={Devart ODBC Driver for Salesforce Marketing

Cloud};Authentication=UserandPassword;Server=https://

webservice.s7.exacttarget.com/Service.asmx;User

ID=00932000000ibZf;Password=******

DRIVER={Devart ODBC Driver for Salesforce Marketing
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Cloud};Authentication=AppCenterClient;AppClientID=8m6chyukyd26sv98

58j5hdeq;AppClientSecret=6Jqz8dgxrMJZaPY5zjdfmB7N

DRIVER={Devart ODBC Driver for Salesforce Marketing

Cloud};Authentication=ServerToServer;Subdomain=mc-3930091-

23laksnmzx1h1nasz;AppClientID=8m6chyukyd26sv9858j5hdeq;AppClientSe

cret=6Jqz8dgxrMJZaPY5zjdfmB7N
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3.5 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows
When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled

or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any

other user login than your own, select Machine-Wide tracing for all user identities. For

example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps

below.

1. Type ODBC Data Sources in the Windows 10 search box (in earlier versions of Windows,

open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

3. If necessary, change the default Log File Path. Make sure that the path is writable by the

application, then click Apply.

4. Click Start Tracing Now.

5. Restart all application processes.

6. Click Test Connection in the DSN settings to make sure the driver is able to connect.

7. Reproduce the issue.

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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8. Click Stop Tracing Now on the Tracing tab.

9. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS
To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.

1. Open the ODBC Administrator.

2. Select the Tracing tab.

3. If necessary, change the default Log file path.

4. Select All the time in the When to trace option.

Creating an ODBC Trace Log on Linux
To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the

[ODBC] section of the /etc/odbcinst.ini file, for example:

[ODBC]
Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

© 2015-2024
Devart. All Rights
Reserved.

Request Support ODBC Forum Provide Feedback

3.7 Supported ODBC API Functions

Supported ODBC Functions
The SQLGetInfo function returns information about the driver and data source. To find out

whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Salesforce Marketing Cloud supports all deprecated functions for backward

compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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SQLAllocHandle ISO 92

Obtains an

environment,

connection,

statement, or

descriptor handle.

SQLConnect ISO 92

Connects to a

specific driver by

data source name,

user ID, and

password.

SQLDriverConnect ODBC

Connects to a

specific driver by

connection string or

requests that the

Driver Manager and

driver display

connection dialog

boxes for the user.

SQLAllocEnv Deprecated

Obtains an

environment handle

allocated from driver.

SQLAllocConnect Deprecated
Obtains a

connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose

SQLDataSources ISO 92
Returns the list of

available data
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sources, handled by

the Driver Manager

SQLDrivers ODBC

Returns the list of

installed drivers and

their attributes,

handles by Driver

Manager

SQLGetInfo ISO 92

Returns information

about a specific

driver and data

source.

SQLGetFunctions ISO 92

Returns the functions

supported by the

driver.

SQLGetTypeInfo ISO 92

Returns information

about supported

data types.

ODBC API Calls for Setting and Retrieving Driver
Attributes

Function Name Support Standard Purpose

SQLSetConnectAttr ISO 92
Sets a connection

attribute.

SQLGetConnectAttr ISO 92

Returns the value of

a connection

attribute.

SQLSetConnectOpti

on
Deprecated

Sets a connection

option

SQLGetConnectOpti Deprecated Returns the value of
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on a connection option

SQLSetEnvAttr ISO 92
Sets an environment

attribute.

SQLGetEnvAttr ISO 92

Returns the value of

an environment

attribute.

SQLSetStmtAttr ISO 92
Sets a statement

attribute.

SQLGetStmtAttr ISO 92
Returns the value of

a statement attribute.

SQLSetStmtOption Deprecated
Sets a statement

option

SQLGetStmtOption Deprecated
Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name Support Standard Purpose

SQLAllocStmt Deprecated
Allocates a

statement handle

SQLPrepare ISO 92

Prepares an SQL

statement for later

execution.

SQLBindParameter ODBC

Assigns storage for

a parameter in an

SQL statement.

SQLGetCursorNam

e
ISO 92

Returns the cursor

name associated

with a statement

handle.
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SQLSetCursorNam

e
ISO 92

Specifies a cursor

name.

SQLSetScrollOption

s
ODBC

Sets options that

control cursor

behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

SQLExecute ISO 92
Executes a prepared

statement.

SQLExecDirect ISO 92
Executes a

statement

SQLNativeSql ODBC

Returns the text of an

SQL statement as

translated by the

driver.

SQLDescribeParam ODBC

Returns the

description for a

specific parameter

in a statement.

SQLNumParams ISO 92

Returns the number

of parameters in a

statement.

SQLParamData ISO 92

Used in conjunction

with SQLPutData to

supply parameter

data at execution

time. (Useful for long

data values.)



Using ODBC Driver 45

© 2024 Enter your company name

SQLPutData ISO 92

Sends part or all of a

data value for a

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose

SQLRowCount ISO 92

Returns the number

of rows affected by

an insert, update, or

delete request.

SQLNumResultCols ISO 92

Returns the number

of columns in the

result set.

SQLDescribeCol ISO 92
Describes a column

in the result set.

SQLColAttribute ISO 92

Describes attributes

of a column in the

result set.

SQLColAttributes Deprecated

Describes attributes

of a column in the

result set.

SQLFetch ISO 92
Returns multiple

result rows.

SQLFetchScroll ISO 92
Returns scrollable

result rows.

SQLExtendedFetch Deprecated
Returns scrollable

result rows.
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SQLSetPos ODBC

Positions a cursor

within a fetched

block of data and

enables an

application to refresh

data in the rowset or

to update or delete

data in the result set.

SQLBulkOperations ODBC

Performs bulk

insertions and bulk

bookmark

operations, including

update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic
Information

Function Name Support Standard Purpose

SQLError Deprecated

Returns additional

error or status

information

SQLGetDiagField ISO 92

Returns additional

diagnostic

information (a single

field of the

diagnostic data

structure).

SQLGetDiagRec ISO 92
Returns additional

diagnostic
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information (multiple

fields of the

diagnostic data

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose

SQLColumnPrivileg

es
ODBC

Returns a list of

columns and

associated

privileges for one or

more tables.

SQLColumns X/Open

Returns the list of

column names in

specified tables.

SQLForeignKeys ODBC

Returns a list of

column names that

make up foreign

keys, if they exist for

a specified table.

SQLPrimaryKeys ODBC

Returns the list of

column names that

make up the primary

key for a table.

SQLProcedureColu

mns
ODBC

Returns the list of

input and output

parameters, as well

as the columns that
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constitute the result

set for the specified

procedures.

SQLProcedures ODBC

Returns the list of

procedure names

stored in a specific

data source.

SQLSpecialColumn

s
X/Open

Returns information

about the optimal set

of columns that

uniquely identifies a

row in a specified

table, or the columns

that are

automatically

updated when any

value in the row is

updated by a

transaction.

SQLStatistics ISO 92

Returns statistics

about a single table

and the list of

indexes associated

with the table.

SQLTablePrivileges ODBC

Returns a list of

tables and the

privileges

associated with

each table.
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SQLTables X/Open

Returns the list of

table names stored

in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

SQLTransact Deprecated
Commits or rolls

back a transaction

SQLEndTran ISO 92
Commits or rolls

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose

SQLFreeStmt ISO 92

Ends statement

processing, discards

pending results, and,

optionally, frees all

resources

associated with the

statement handle.

SQLCloseCursor ISO 92

Closes a cursor that

has been opened on

a statement handle.

SQLCancel ISO 92
Cancels an SQL

statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
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SQLDisconnect ISO 92
Closes the

connection.

SQLFreeHandle ISO 92

Releases an

environment,

connection,

statement, or

descriptor handle.

SQLFreeConnect Deprecated
Releases connection

handle.

SQLFreeEnv Deprecated
Releases an

environment handle.
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4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Salesforce Marketing Cloud with ODBC-

compliant tools.

DBeaver

DBxtra

Oracle Database Link

Microsoft Access

Microsoft Excel

OpenOffice and LibreOffice

PHP

Power BI

Python

QlikView
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SQL Server Management Studio

SSIS

Tableau
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4.1 Using in DBeaver

DBeaver Overview
DBeaver is a free, open source multiplatform database management tool and SQL client for

developers and database administrators. DBeaver can be used to access any database or

cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,

Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features

you'd need when working with a database in a GUI tool, such as:

SQL queries execution

Metadata browsing and editing

SQL scripts management

Data export/import

Data backup

DDL generation

ER diagrams rendering

Test data generation

BLOB/CLOB support

Database objects browsing

Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports

NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,

SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though

that you can access a MongoDB database from DBeaver Community Edition using the

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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respective Devart ODBC driver. For the purposes of this guide, we'll use the Community

Edition of DBeaver to retrieve data from Salesforce MC via the Open Database Connectivity

driver.

Creating an ODBC Data Source to Use Salesforce MC
Data in DBeaver
1. Click the Start menu and select Control Panel.

2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system

or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for Salesforce MC in the list.

5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Salesforce MC with DBeaver, SQL_WVARCHAR data types

may be displayed incorrectly in DBeaver. To prevent this, you need to set the string data

types to Ansi either in the Advanced Settings tab of the driver configuration dialog or directly

in the connection string (String Types=Ansi) — all string types will be returned as

SQL_CHAR, SQL_VARCHAR and SQL_LONGVARCHAR.
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Connecting to Salesforce MC Data from DBeaver via
ODBC Driver for Salesforce MC
Follow the steps below to establish a connection to Salesforce MC in DBeaver.

1. In the Database menu, select New Database Connection.
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2. In the Connect to database wizard, select ODBC and click Next.

3. Enter the previously configured DSN in the Database/Schema field.
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4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Salesforce MC Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all

the tables in Salesforce MC database. To view and edit the data in a table, you need to right-

click on the target table name and select View data.The content of the table will be displayed

in the main workspace.

If you want to write a custom SQL query that will include only the necessary columns from the
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table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.
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4.2 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC
This article explains how to configure Oracle Database Gateway for ODBC. If your data is

stored in a non-Oracle database system or cloud application, and you need to access it from

an Oracle Database server, you can create a database link to an Oracle Database Gateway

for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,

remote Oracle servers. Any ODBC-compatible data source can be accessed using the

gateway and the appropriate ODBC driver. The driver must be installed on the same machine

as the gateway. The non-Oracle system can run on the same machine as the Oracle server

or on a different machine. The gateway can be installed on the machine running the non-

Oracle system, the machine running the Oracle database or on a third machine as a

standalone.

Configure the Initialization File
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After installing the gateway and the ODBC driver for Salesforce MC, create an initialization file

for your Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in

the ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the

sample initialization file and rename it. The name must be prefixed with init — for example, 

initSalesforce MC.ora. You need a separate initialization file for each ODBC data source.

After creating the file, set the HS_FDS_CONNECT_INFO parameter to the system DSN that you

created earlier, for example:

HS_FDS_CONNECT_INFO=Salesforce MC

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with

the Oracle database. Information about the gateway must be added to the listener.ora

configuration file which is located in the ORACLE_HOME\NETWORK\ADMIN\ directory. The following

example is the address on which the Oracle Net Listener listens (HOST is the address of the

machine on which the gateway is installed):

LISTENER =
    (DESCRIPTION_LIST =
        (DESCRIPTION =
          (ADDRESS = (PROTOCOL = TCP)(HOST = localhost)(PORT = 1521))
        )
    )

Add an entry to the listener.ora file to start the gateway in response to connection requests.

The SID of the gateway (SID_NAME) must be the same in listener.ora and tnsnames.ora.

ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new

settings, stop and restart the Oracle Net Listener service.

SID_LIST_LISTENER=
   (SID_LIST=
      (SID_DESC=
         (SID_NAME=Salesforce MC)
         (ORACLE_HOME=D:\ORACLE_HOME)
         (PROGRAM=dg4odbc)
      )
   )

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in

ORACLE_HOME\NETWORK\ADMIN directory. The SID must match the value specified in the

listener.ora file.

Salesforce MC =

https://www.devart.com/odbc/exacttarget/
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  (DESCRIPTION =
    (ADDRESS = (PROTOCOL = tcp)(HOST = localhost)(PORT = 1521))
    (CONNECT_DATA =
      (SID = Salesforce MC)
    )
    (HS = OK)
  )

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the 

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username"  IDENTIFIED BY "password"  USING 'tns_name_entry';

dblink is the complete database link name. tns_name_entry is the Oracle Net connect

descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a

query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC
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4.3 Using in DBxtra

Troubleshooting Salesforce MC ODBC Connection in
DBxtra
This page explains how to troubleshoot your ODBC connection to Salesforce MC in DBxtra.

Due to incompatibilities between DBxtra and Salesforce MC, leaving the SQL dialect property

to its default might present various issues. To resolve compatibility issues, set the property to 

MS Access 2000/XP/2003 or ANSI SQL/2003 for DBxtra version 11.0.1 or newer, and to ANSI

SQL/2003 for versions prior to 11.0.1.
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4.4 Using in Microsoft Access

Connecting Microsoft Access to Salesforce MC Using an
ODBC Driver
This article explains how to connect Microsoft Access to Salesforce MC through the standard

ODBC interface. Microsoft Access is a dababase management system that combines the

relational database engine with a graphical user interface. Access can be used as a

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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substitution for spreadsheet applications like Excel to organize, store, and retrieve large

amounts of related data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Salesforce MC data either by importing it or

creating a table that links to the data. Devart ODBC drivers support all modern versions of

Access. It is assumed that you have already installed and configured a DSN for ODBC driver

for Salesforce MC. For the purpose of this article, we tested an ODBC connection to

Salesforce MC through our ODBC drivers in Microsoft Access 2003, Microsoft Access 2007,

Microsoft Access 2010, Microsoft Access 2013, Microsoft Access 2016, Microsoft Access

2019. The following steps describe how to use Microsoft Access 2019 to import or link to your

data in Salesforce MC.

Importing Salesforce MC Data Into Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Salesforce MC and click OK.

7. In the Import Objects dialog box, select the tables that you want to import, and click OK.

8. If the database objects have been successfully imported, you should the see the

corresponding message in the dialog box. If you want to save the import steps to quickly

repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Salesforce MC Data in Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

https://www.devart.com/odbc/exacttarget/
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2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source

by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Salesforce MC and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields

that uniquely identify each record in the table. To avoid inconsistencies, it is recommended

to select the primary key in the Salesforce MC table as the unique record identifier. You are

linking multiple tables, you will be prompted to select unique record identifiers for each of

the selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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4.5 Using in Microsoft Excel

Connecting to Salesforce MC from Microsoft Excel using
ODBC Driver for Salesforce MC
You can use Microsoft Excel to access data from a Salesforce MC database using ODBC

connector. With ODBC Driver, you can import the data directly into an Excel Spreadsheet

and present it as a table. Make sure that you use matching Excel and ODBC Driver, e.g. if

you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various

data sources using our ODBC drivers.

Connecting Excel to Salesforce MC with Get & Transform (Power Query)

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
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Connecting Excel to Salesforce MC with Data Connection Wizard (Legacy Wizard)

Connecting Excel to Salesforce MC with the Query Wizard

Connecting Excel to Salesforce MC with Microsoft Query

Connecting Excel to Salesforce MC with PowerPivot

Connecting Excel to Salesforce MC with Get &
Transform (Power Query)
You can use Get & Transform (Power Query) to connect to Salesforce MC from Excel with

ODBC. This method assumes that you've installed an ODBC driver for Salesforce MC.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured

your ODBC driver yet, you can expand the Advanced Options dialog box and enter the

connection string for your data source (without credentials, which are defined in the
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credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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If your database is not password-protected or you've already specified your credentials in the

ODBC data source settings, select Default or Custom and press Connect

4. In the window that appears, select the table you want to retrieve data from, and click Load.
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The data from the table will be a displayed in an Excel spreadsheet where you can further

work with it.

Connecting Excel to Salesforce MC with Data
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Connection Wizard (Legacy Wizard)
You can use this option to connect to OLE DB or ODBC external data source that has

already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.

2. In the opened dialog, select ODBC DSN and click Next to continue.

3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Salesforce MC with the Query
Wizard
You can use this option to create a simple query for retrieving data from Salesforce MC to

Excel via ODBC driver.

1. Open Excel, in the main menu, click the Data tab.

2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.

3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

5. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.

6. If you plan to further use the query, you can save it by clicking the Save button on the right.

7. Select Return Data To Microsoft Excel and click Finish.

8. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.
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Connecting Excel to Salesforce MC with Microsoft Query
You can use this option to create a more complex query for retrieving Salesforce MC data to

Excel via ODBC driver.

1. Start Excel, click the Data tab.

2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source

name - Devart ODBC Salesforce MC). Uncheck Use the Query Wizard to Create/Edit

Queries and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Salesforce MC with PowerPivot
You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,

using data source name - Devart ODBC Salesforce MC), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a

query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.
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4.6 Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Salesforce MC from

SQL Server Management Studio using ODBC Driver for Salesforce MC.

Creating a Linked Server

Troubleshooting in SSMS

© 2015-2024
Devart. All Rights
Reserved.

Request Support ODBC Forum Provide Feedback

4.6.1 Creating a Linked Server

Requirements
In order to avoid incorrect integration with MS SSMS, the working environment must meet the

following conditions:

The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

The driver, studio, and SQL Server must be of the same bitness. For example, if you are

using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure

the 64-bit version of the driver using ODBC Administrator launched from %windir%

\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC

Administrator - launch it from %windir%\SysWOW64\odbcad32.exe.

ODBC Driver for Salesforce Marketing Cloud and SQL Server must be installed on the

same computer.

.NET Framework 4.5 must be installed on the computer.

Connecting to Salesforce MC from SQL Server
Management Studio using ODBC Driver for Salesforce
MC
You can use the Microsoft SQL Server Management Studio to connect your Salesforce MC

data to an SQL Server instance. Linked Server is a tool of MS SQL Server that allows to

execute distributed queries to refer tables stored on non-SQL Server datbase in a single

https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html


Using in Third-Party Tools 69

© 2024 Enter your company name

query. With linked servers, you can execute commands against different data sources such

as Salesforce MC and merge them with your SQL Server database. You can create a linked

server with one of these methods: by using the options in the Object Explorer or by executing

stored procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Salesforce

MC:

1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Salesforce MC
You can follow the steps to create a linked server for Salesforce MC in SQL Server

Management Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.

2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.

3. Configure your linked server in the dialog box:

Give a name for your server in the Linked server field.

Under Server type, select Other data source .

Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down

list.

In the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for

Salesforce MC . Alternatively, you can input the ODBC Driver connection string in the 

Provider field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can

now issue distributed queries and access Salesforce MC databases through SQL Server.

Retrieving Data From Salesforce MC
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Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is

enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on

it

In the appeared Provider Options window, enable the Allow inprocess checkbox:

Create a new Linked Server
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Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

Now you need to input the Linked Server name, e.g. SALESFORCEMC. In the Product Name

and Data Source fields you need to indicate the System DSN that you've previously created -

more info on System DSN setup can be found here.
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The Salesforce MC tables are already available to be fetched. To query the linked server,

click New Query in the toolbar:

Enter your SQL query in the editor window and click Execute to run the query:
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As a result, you can see the contents of the selected table retrieved directly from the

Salesforce MC account you are connected to.

See also
Troubleshooting SSMS
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4.6.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with

DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security

settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its
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properties:

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions

available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are

connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-

11D1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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After this you should be able to edit MSDAINITIALIZE security settings .

See also
Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"
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4.7 Using in OpenOffice and LibreOffice

Connecting to Salesforce MC from OpenOffice and
LibreOffice using ODBC Driver for Salesforce MC
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https://support.microsoft.com/en-us/kb/2647989
https://www.devart.com/company/contactform.html?category=0&product=odbc/exacttarget
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/exacttarget/feedback.html


ODBC Driver for SalesforceMC78

© 2024 Enter your company name

The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data

sources using the respective driver. You can access Salesforce MC data from Open Office

Base or LibreOffice Base — desktop database management systems. Note that the

Windows version of OpenOffice is 32-bit, and you may get the error “The specified DSN

contains an architecture mismatch between the Driver and Application” when trying to access

a data source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-

bit version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for

Salesforce MC, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.

https://www.devart.com/odbc/exacttarget/
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2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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3. Specify the name of the data source you want to connect to. You can either type the name

of your data source into the field, e.g. ODBC Driver for Salesforce MC, or you can click

Browse, double-click the data source you need, and then click Next.
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4. If your database requires a user name, type it into the User name field. If you are

connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Salesforce MC and leave these fields empty in Database Wizard.

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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You will be prompted to give a name to your new database and select the directory where you

want to store it.
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6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-

click the table name.
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7. To create an SQL query, click Queries in the Database pane, then click Create Query in

SQL View…
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Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.
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4.8 Using in PHP

Connecting to Salesforce MC from PHP using ODBC
Driver for Salesforce MC
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PHP is one of the most popular programming languages for website development. ODBC

drivers are connectors that make PHP development database agnostic — your software

written in PHP will function with any vendor's database management system. You can use

functions like odbc_exec() to prepare and execute SQL statements against any databases

like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-

based database. You can establish a connection to them using ODBC interface. With our

ODBC drivers, you can access various data sources and retrieve tables and fields from a

database.

Below is a sample PHP script for accessing Salesforce MC via ODBC. The script connects

to Salesforce MC database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the

function takes three mandatory parameters: the data source name, username and password.

If your database is not password-protected or doesn't require a username, leave these

parameters empty. In the following example, a connection is established using the 

odbc_connect() function in PHP.

 <?php
    $user = "myusername";
    $password = "mypassword";
    $ODBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Salesforce Marketing Cloud};Authentication=User and Password;Server=myserver;User ID=myuserid;Password=mypassword", $user, $password);

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT

statement against the dept table in the autotest database.

 $SQLQuery = "SELECT * FROM autotest.dept";
    $RecordSet = odbc_exec($ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While

odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML

table. After all rows from the result set have been printed, the odbc_close() function closes

the connection.

   while (odbc_fetch_row($RecordSet)) {
        $result = odbc_result_all($RecordSet, "border=1");

https://www.devart.com/odbc/exacttarget/
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    }
    odbc_close($ODBCConnection);
?>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.
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4.9 Using in Power BI

Importing Salesforce MC Data into Power BI Through an
ODBC Connection
Power BI is a popular business intelligence solution that is comprised of services, apps, and

connectors that allow you to pull raw data from various sources and create meaningful

reports. To connect Power BI to a data source such as Salesforce MC, you can use a

corresponding ODBC driver.

This tutorial explores how to connect to Salesforce MC and import data into Power BI

Desktop using an ODBC driver. It is assumed that you have already installed and configured

a DSN for ODBC driver for Salesforce MC.

1. Run Power BI Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect

to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and

select the previously configured DSN for Salesforce MC

4. If you would like to enter a SQL statement to narrow down the returned results, click the 

Advanced options arrow, which expands the dialog box, and type or paste your SQL

statement.

5. Click OK. If your data source is password-protected, Power BI will prompt you for user

credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents

of the database objects by clicking on them.

7. To load the Salesforce MC data into Power BI for analysis, select the needed table and
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click Load.
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4.10 Using in Python

Installing the ODBC Driver for Salesforce Marketing
Cloud
One of the most convenient methods to connect to an external database or access cloud

data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to

work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download

the appropriate installer and run it. You will also need to install the pyodbc module — the

easiest way to do that is by using the pip install pyodbc command in the Python interactive

mode. Next, you need to download the ODBC Driver for Salesforce MC. To use the ODBC

driver as a translation layer between the application and the database, you need to configure it

by following the installation instructions.

Connecting to Salesforce MC from Python using ODBC
Driver for Salesforce MC
Here’s an example to show you how to connect to Salesforce MC via Devart ODBC Driver in

Python. First we import the pyodbc module, then create a connection to the database, insert a

new row and read the contents of the EMP table while printing each row to the Python

interactive console. To execute the script, you can type the code directly in the interactive

console or add the code to a file with the .py extension and run the file from the command

prompt.

Step 1: Connect

import pyodbc
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Salesforce Marketing Cloud};Authentication=User and Password;Server=myserver;User ID=myuserid;Password=mypassword')

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
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database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott', 'Manager', 545)")

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The

cursor.fetchone() function iterates over the result set returned by cursor.execute() while the

print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
 print (row)
 row = cursor.fetchone()
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4.11 Using in QlikView

Connecting to Salesforce MC from QlikView using
ODBC Driver for Salesforce MC
This tutorial describes how to connect and configure QlikView to retrieve data from

Salesforce MC for further analysis. QlikView is a data visualization tool that connects and

pulls data from different popular databases like MySQL, MongoDB, Oracle, SQL Server,

Postgres, etc. to present it in a single view. The business intelligence platform identifies

relationships in your data and discovers patterns and opportunities to support your decision

making.

QlikView supports the ODBC connectivity interface for communication with external data

sources. An ODBC data source must be configured for the database you want to access.

You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for Salesforce MC,

perform the steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
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wizard and open File > Edit Script (CTRL+E).

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select

the Data Source you created earlier, type in the User ID and Password if your database is

password-protected. You can test the connection by choosing Test Connection. The

Connection Test succeeded message should appear. Click OK to connect to your data

source.
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3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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5. Once the data has been fetched, you can choose a table layout to present the data in a

table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to

the tablebox and click OK.
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4.12 Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to

perform various data migration tasks. When using Devart ODBC Driver for Salesforce MC as

a translation layer between the data source and SSIS, the driver and SSIS communicate via

Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the SQLExecDirect function,

an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues

to fetch data from a data source via ODBC version 3.x. To prevent any issues when using

SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the 

Advanced Settings tab and select Ver 2.x from the ODBC Behavior dropdown.
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4.13 Using in Tableau

Importing Salesforce MC Data Into Tableau Through an
ODBC Connection
This article explains to establish and ODBC connection to Salesforce MC from Tableau

Desktop. Tableau is a data visualization tool that allows you to pull in raw data, perform

analysis on it, and create meaningful reports to get actionable insights. With Tableau Desktop

and our suite of ODBC drivers, you can connect to various relational and non-relational

databases, both cloud and on-premise.

1. Run Tableau Desktop.
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2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured

for Salesforce MC. Alternatively, if you have not created a DSN, you can choose the Driver

option and select Devart ODBC Driver for Salesforce MC from the drop-down.

5. Click Connect.

6. After a successful connection, click Sign in.

7. Select the needed database and schema in Salesforce MC.

8. You should see the list of all tables you have access to in the connected data source.

9. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the

data, or click New Custom SQL to write a query that will select only specific data from the

table.

10.Hit Update Now to retrieve and display the data.
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